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Micro Focus Enterprise Test Server 2.3
Update 1 Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Test Server is a test execution environment that allows you to test mainframe applications on a
low cost Windows platform. You can use variables or the tilde syntax can be used to relieve the mainframe
test bottleneck by allowing you perform a substantial part of your application testing on Windows prior to
moving the application back to the mainframe for final pre-production testing and deployment.

Enterprise Test Server supports IBM COBOL, High Level Assembler, CICS, IMS TM and DB, JCL, DB2,
and z/OS file formats. It also supports common batch utilities such as SORT. This means that applications
running under Enterprise Test Server behave just as they would on the mainframe, so you can perform a
wide variety of pre-production testing activities on low-cost hardware rather than on the mainframe.

To configure Enterprise Test Server your development administrator will work with the development teams
to set up the Enterprise Test Server environment on your central Windows test server, as follows:

1. Enterprise Developer is used to recompile application source code for execution on Windows.
2. Test data sets or databases are made available either locally or on the mainframe through remote

access.
3. Development and test teams are trained to ensure that they understand how to test applications within

the Enterprise Test Server environment and to switch between the different test regions it supports.

Enterprise Test Server comes in the following product variants:

• Enterprise Test Server which is the standard Test Server product and is a mainframe Test Execution
environment.

• Enterprise Test Server Premium which provides two additional capabilities to extend the test execution
platform:

• Data Manager, which allows you to subset and mask mainframe data which is then available for
testing under Enterprise Test Server.

• Test Automator which is a test automation capability that allows you to create automated test suites
that can be played back against Enterprise Test Server or against the host.
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What's New
This release provides enhancements in the following areas:

• Application Server JCA support for Enterprise Server
• Enterprise Server
• Data File Tools
• Database Access - OpenESQL
• Database Access - SQL Option for DB2
• File Handling
• iFileshare - Fileshare under Enterprise Server (Early Adopter Product)

Application Server JCA support for Enterprise Server

Back to Top

This release provides support for:

• Automatic connection recovery to an active Java application server when an enterprise server region is
restarted. This applies to:

• COBOL resource adapters
• CICS resource adapters
• All CICS API based programs

• The IBM implementation of CICS resource adapter for WebSphere 8.5 and JBoss 7.1.1.

Data File Tools

Back to Top

This release provides improved security and increased support for more file types. Features include:

• Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

• When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

• Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Database Access - OpenESQL

Back to Top

This release provides the following new features:

• Support for the Oracle fully managed ODP.NET driver.

Database Access - SQL Option for DB2

Back to Top

This release provides the following new features:

• Import/export of XML with SQLWizard/DSNUTILB(XUTLB)
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• New XDBSetup utility for TS/Citrix environments
• Using Migrate to move XML tables from z/OS DB2 to XDB
• Support for Temporal Tables

Enterprise Server

Back to Top

This release provides support for the SO_RCVTIMEO and SO_SNDTIMEO timeout options of EZASOKET
support that help reduce the risk of applications becoming unresponsive due to EZASOKET APIs not
completing.

File Handling

Back to Top

The following enhancements have been made to file handling processes:

• A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.

• Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

iFileshare - Fileshare support under Enterprise Server (Early Adopter Product)

Back to Top

Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.

You can configure iFileshare to offer enhanced availability for mission critical files by configuring a high
availability group, consisting of a primary iFileshare server and a number of stand-by servers.

Files that are critical to your application can be replicated from a primary server onto the stand-by servers.
Should the primary server fail, you have up-to-date data (minus any in-flight transactions) available.

If Enterprise Server work is being hosted on the primary region within the group, the setup must be
consistent on all standby Fileshare hosting regions so that work can continue in the event of a failover.

Mainframe support and emulation

Back to Top

This release provides the following enhancements:

• Support for using multiple catalog files (up to 32).
• Support for storing the spool files in a location that differs from the location of the catalog file.
• Enhanced support for searching the catalog using wildcards.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Communications Server
• Enterprise Server
• IBM Language Environment for OS/390 & VM Support
• JCL Support
• Run-Time System
• SQL: OpenESQL
• SQL Option for DB2

Communications Server

Back to the list

• A new option, [Operation] synchronous=yes (or 1, or Yes, or y or Y) is now supported in the
Fileshare listener configuration.

Enterprise Server

Back to the list

• In situations where the crossregion option of the shareoptions parameter is either 1 or 2, both a CICS
and a JCL job could have the same file open for IO. This has been fixed. In addition, the '-oo' (and the
synonymous '-o ') option of the casfile command has been deprecated. If '-oo' is used, you will now
receive a return code 4 (warning). Instead of '-oo', you need to use the '-ooi' option (open immediate). If
-oo is used with a region configured for VSAM shareoption use, the '-ooi' option is now forced.

2839272 (1101672)
• When using an external security manager to secure a region, the EXEC CICS START TRANSID API

now works as expected and honors the USERID option. Previously, the started transaction would run
under the authority of the user that executed the EXEC CICS START API.

2835112 (1101201)

IBM Language Environment for OS/390 & VM Support

Back to the list

• When calling SETENV, SYSOUT(?) can be specified. This designates the file as a spool file but will not
update its CLASS.

2841220 (1101955)

JCL Support

Back to the list

• The return code from a JCL printer exit will now be checked. If it is non-zero, the dataset that was sent
to the printer exit will be moved to the OUT-HOLD queue rather than to the PRINTED queue. To release
the dataset, click "Release" in the ESMAC view - this will also present the dataset again to the printer
exit.
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2834206 (1101079)
• Under Enterprise Server, flushing an active job previously resulted in all associated spool records for

the job being deleted, but left the job running. A subsequent attempt to kill the running job using casout/
seeout failed due to the job spool record no longer existing. This change causes the flush request to fail
if the job is active. You must kill the active job first before attempting to flush it.

• The catalog search facility has been enhanced to provide a quicker return when using wildcards in the
dataset name selection.

2698700 (1094266)
• REXX can now be executed in VSE via IKJEFT01 and IRXJCL using in-stream data.

2831984 (1100883)

Run-Time System

Back to the list

• The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.

If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:

mfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)
• Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE

class condition tests:

• IS [NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

• IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.

• IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.
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When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL

Back to the list

• The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

• Run a DSN bind against the customer database. Or:
• Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss

\InstallDigitsFunction.sql script.

This is a one-time only change to the database.

2843818 (1102248)

SQL Option for DB2

Back to the list

• Spurious errors were sometimes returned while querying using an ALIAS.

2830383 (1100609)
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

• In Enterprise Developer 2.3, some job scheduling tools from third-party vendors might stop
communicating with Enterprise Server. This might have an impact on our external partners who
integrate with Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur
with job schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment
with the path set. Click here for more information about the issue and how to work around it.

Linking

• Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• CICS BMS Compiler
• CICS Support
• Common Communications Interface
• Communications Server
• Documentation
• Enterprise Server
• File Handling
• IBM Language Environment for OS/390 & VM Support
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• MFIO
• Micro Focus Common Client
• Micro Focus Directory Server
• Monitoring and Management
• Run-Time System
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Adis

Back to the list

• Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.

2848637 (1102857)

Assembler Support

Back to the list

• The DCB macro requires the DSORG= parameter in order to be more compatible with the mainframe.
This parameter has now been added to the Assembler sample programs PGASM04.mlc and
qsamex4.mlc in the Mainframe\Assembler\Classic\QSAM directory in the installation location of the
samples so that these files now assemble without any errors.

CICS BMS Compiler

Back to the list
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• A new menu item, Customize IDE, on the Options menu of the BMS Painter utility enables you to
specify your preferences for a font face and font size of the text within the BMS Screen Painter and in
the Output window.

2835960 (1101266)

CICS Support

Back to the list

• Some issues in COBOL Web services and CICS COMMAREA-based web service environments when
EXCI was involved have been fixed. Previously, an ADPL abend was issued when a CICS program
executed an EXEC CICS SYNCPOINT in a CICS COMMAREA-based web service environment. This
has been fixed.

2848968 (1103075)
• When using ISC, ADPL could abend and the client terminated the transaction after changes introduced

by CWS work for LINK without SYNCONRETURN. Enterprise Server now allows the commit to take
place when it receives the end of a conversation and when dfhzcsmi is issuing the commit.

2848069 (617536)
• When ES_XA_RECONNECT is set to true and a number of retries is defined for

ES_XA_nnnn_NB_RETRIES (where nnnn is the XAID), the number of retries was not being checked,
and the XA switch was disabled immediately after a connection issue occurred. The value defined in
ES_XA_nnnn_NB_RETRIES is now honored and, when a connection issue occurs, the switch is not
disabled until after the connection has been attempted for the number of retries.

2843692 (1102209)
• Previously, the product did not identify PL/I programs as such and defaulted to ASCII. PL/I program are

now correctly identified as such and use the API-CODESET value that has been set by PL/I in the
CICS-API control block.

2841424 (1102109)

• An ENQ taken for a write-lock when writing to a recoverable TQD was not released at the end of a task.

2849271 (1102960)
• When you start a region, there is no longer a delay of one second per printer when the printers are

installed.

2847778 (1102784)
• CASPRT now calls the casmguex exit so that the CASCL0020I message can be suppressed from the

console.log file.

2847778 (1102785)
• A problem in the dfhgglbl module when a SPOOL process was active could cause a CICS process

cassplcp to fail to start with a run-time system error 114.

2840334 (1101859)
• Previously, the PROTECT option was not recognized when using START/PROTECT with TRANCLASS.

2832905 (1100929)
• When using mirror transactions, if a resource has browse placeholders or is recoverable, or the lock has

been acquired, a mirror transaction becomes a long-running mirror and does not end until the issuing
transaction ends the logical unit of work - on SYNCPOINT or RETURN. Any resources that the mirror
has acquired are freed when the initiating transaction issues the appropriate command to free them.
Previously, mirror transactions were only released on RETURN. They are now also released on
SYNCPOINT.

2829652 (1100859)
• When installing a terminal that was not in use, an incorrect flag was checked. An error message

"CASRD0025E 3270 Terminal entry xxxx is out of service or it is in use" was displayed.
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2821671 (1099558)
• Previously, when using TRANCLASS, if a TSQ was deleted in one thread while another thread was

trying to read the queue at the same time, Enterprise Server returned an ITEMERR error instead of
QIDERR because the queue had been deleted.

2819309 (1099471)

• A problem adding a new startup group on the casrdo97 startup list ESMAC page immediately after
deleting a group on the same page has now been corrected.

2850524 (1103106)
• When sending a response back, the product now escapes any HTML sensitive characters in order to

avoid an XSS scripting vulnerability.

2846631 (1102678)

• The behavior of non-facility transactions was too silent. Messages are now being sent to the console
about transaction attach failures. The message KC0041 is now sent to the console for asra abends.

2845530 (1102445)

• Performing a phasein on an active program could corrupt the local storage chain for the SEP which was
running that program. A Run-Time System error could occur.

2846132 (1102972)
• The casfile -ooi option failed with an RTS114 error when opening a CICS FCT of the Alt Index type.

2845760 (1102598)

Common Communications Interface

Back to the list

• Components that use the SSL/TLS support in CCI, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server

Back to the list

• The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.

2847439 (1102743)

Documentation

Back to the list

• The documentation has been updated to include the "ra.xml file" topic describing the contents of the
ra.xml file, which includes a list of properties that configure your CICS resource adapter.

2828775 (1101075)
• The topic "DEFINE CLUSTER" in the product help has updated information about the RECORDSIZE

parameter and the file that will be created.

2830878 (1100668)
• The instructions in the product help on how to run .NET COBOL applications from a network server

have been updated. These now include details about how to make the appropriate .NET run-time
assemblies available to your applications and how to elevate the security permissions levels of the
applications.

2826751 (1100478)
• When handling XML files, after a successful WRITE action, the size of the XML file written is returned

as the status code.
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2587541 (1085484)
• When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This

switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.

• An Enterprise Server error message has been added to the help pages for CASKC0048, process soft-
killed failed and was hard-killed.

2846350 (1102574)
• The ldpli topics have been updated to include information about native ld options.

2840325 (1101829)
• The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.

2836105 (1101281)

• The "mfsupport" utility is now correctly named and spelled as MFSupportInfo, for Windows platforms.

2848869 (1102896)
• In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been

changed from 48 to 60.

2844479 (1102300)
• The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.

2844210 (1102719)
• Additional information added to the help pages for the audit event codes emitted by the External

Security Facility (ESF) and Micro Focus Directory Server (MFDS).

2842807 (1102120)
• If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using

a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true' or 'false'.

2837405 (1101440)
• The product documentation has been updated to include the topic "IMS and GSAM Databases" located

in the table of contents under Programming > IMS Support.

2789025 (608922)

• Option D(o) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.

2839572 (1101835)

Enterprise Server

Back to the list

• The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.

2847684 (1103145)
• Cancelling a job sends a sigterm signal indicating that the process needs to terminate. If the process

did not complete, Enterprise Server would then send a sigterm again instead of sending a sigkill signal.
A sigkill signal is now correctly sent in such situations.

2845534 (1103261)
• When processing a WSBIND that contain nested occurs levels, the group level is now correctly

maintained.
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2844738 (1102697)
• XA transactions will now end when an ECI request fails with PGMIDERR.

2843668 (1102276)
• The order in which user privileges are checked when accessing cataloged files has changed. First, a

check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.

2842162 (1102048)
• Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an

abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.

2841974 (1102004)
• When the targetService option was enabled for the JMS Invoke Webservice, no response was returned

to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI0112.

2841602 (1101959)
• casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get

deleted when using Delete from the ESMAC page.

2839657 (1101706)
• Mainframe Subsystem support for the EZ Sockets APIs in Enterprise Server now includes the

SO_RCVTIMEO and SO_SNDTIMEO socket options. Support for these is limited to the options
provided by the underlying Operating System.

2833375 (1101002)
• A Run-Time System error 114 no longer occurs when a GET request is received.

2825851 (1100157)
• You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already

using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.

2821228 (1099658)
• You no longer receive a memory leak in cassi processes when using the Micro Focus External Call

Interface.

• If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.

2836688 (1101388)

• The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly
matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").

2854402 (1103604)
• When using LDAP-based security immediately after installing Enterprise Server, with the sample access

rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.

2838380 (1101547)
• The LISTREFERENCES command now works correctly when the resource class names use special

characters.
• When using a JES initiator in the GLM, the locks could not be released properly if a job was running in

that initiator while another process was waiting for the locks.
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2838871 (1101612)

File Handling

Back to the list

• OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.

2849233 (1102953)
• If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified

at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.

2842825 (1102218)
• Rebuild now correctly processes the key structure defined through an options file.

2837028 (1101412)
• Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg

configuration file (e.g. [file.dat]).

2832386 (1100932)

• Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /k).

2837756 (615857)
• Rebuild now allows the case where "9" is specified after ":"

2836782 (1101437)

• SEP corruption no longer occurs when running a SORT operation.

2843320 (1102182)
• MFSORT now returns a 9/018 error when an incorrect record length is specified.

2834614 (1101131)

IBM Language Environment for OS/390 & VM Support

Back to the list

• The Language Environment jobs which are run after an abend now runs correctly.

2847262 (1102897)
• A problem with multiple calls to MFLEINIT without subsequent process termination causing exhaustion

of virtual file space has been corrected.

2829308 (1101231)

IMS Support

Back to the list

• The IMS database editor could not access a database directly. The editor was only functional when
editing a database using a PCB in a PSB.

2849835 (1103025)
• Direct access to a secondary index database that uses system generated /SX fields no longer fails

when the primary database is compiled using the SXRBAFORMAT"2" directive.

2845024 (1102464)
• Read only access to an IMS database from a batch application failed after IMS DB had performed an

automatic backward recovery. Restarting the server corrected this condition.
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2844983 (1102431)
• A BMP program using a PSB that specified CMPAT=NO sometimes returned incorrect results to a DB

call.

2844084 (1102463)
• Batch IMS applications that access IMS database data directly can override ES_IMSDAT and access

this data in different folder locations.

2833328 (1100981)
• A DBD from a DOS/VS environment that made use of an assumed START= parameter on the SEGM

FIELD statement was previously unsupported. This support requires the IBMPLATFORM=DOSVS
DBDGEN directive.

• A protection fault resulted when attempting to load an IMS database using MFDAS when the ACB was
missing.

• The Admin SEP no longer abends with an RTS 114 error when starting an MPR with an MPR name.

2845871 (1102500)

• The attribute byte for a dynamic attribute was being improperly converted. This has been corrected.

2849654 (1103033)
• The limit of labelled DFLDS and MFLDS has been increased from 500 to 1000 per MFS. This enables

you to use MOD 5 type of screens (24 X 132) which can contain many more fields than the more
common MOD 2 type of screens (24 X 80).

2849190 (1102943)
• The MFS generator has been updated to fix an issue with /FOR Type-5 screens. To apply this fix, you

must regenerate your MFS source files using this release of the product. Also, the device type specified
in the MFS for MOD 5 screens (27 X 132) must be 3270-A7.

2848896 (1102915)
• MFS files with literals of the form "DFLD G'<dbcs characters>',POS=(03,1),LTH=54,ATTR=(PROT)"

were seeing the last byte of the literal clipped in the generated control block and on screen at run time.
This problem has been fixed and all G literals should generate and display correctly.

2848014 (1102773)
• If the trancode is 8 bytes in length and the application does not accept a trailing space as part of the

input message, you must ensure that the trailing space flag is checked in the enterprise server
configuration. In addition, a fix has been made to IMS code that applies to conversational application
when the trancode is less than 8 bytes. When the conversation starts for the very first time, IMS now
strips the trancode out of the input message and puts it in the trancode area of the SPA buffer. The input
message is then shifted to the left by the length of the trancode. Afterwards, the input message is
formatted strictly by the MFS input definitions.

2837836 (1101690)
• If the last output LPAGE is missing its COND statement, an error message is considered unnecessary

and is no longer issued. You will still receive an error, if the COND statement is missing from any output
LPAGE that is not the last.

2833816 (1101032)
• The NULL FILL value in the input field (pfkey) is now correctly recognized and NULL FILL characters

are stripped out from the input message and the message is compressed. When the field following the
field (pfkey) with NULL fill characters is the trancode field, MFS now invokes the application associated
with the trancode. Katakana characters are not displayed correctly. To work around this issue, you need
to set PCOMM or RUMBA codeset 930 which is compatible with MFCODESET=9122.

2833225 (1100955)

• The APARM returned to the AIBTDLI INQY ENVIRON call is now restored with each execution of the
INQY call.

2846411 (1102605)
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• A previous update had updated the behavior of a CHNG call issued from an OTMA- or IMS Connect-
submitted transaction such that the destination was assumed to be the OTMA client. In some
circumstances, the previous behavior of assuming a non-OMTA client is desirable. To use the previous
behavior, set the ES_IMS_BYPASS_OTMA_DEST_RES Enterprise Server environment variable to
ES_IMS_BYPASS_OTMA_DEST_RES=y.

2835781 (1101595)
• For servers using external security, IMS printers sometimes failed to reconnect after disconnecting.

2835352 (1101479)

• The IMS Database Utility could not load an IMS database when a special character such as "@", "#" or
"$" was used in the first position of the segment name definition (DBD SEGM NAME=).

2848521 (1102845)
• On Red Hat Linux, incorrect results were returned to an EXECDLI application program. The WHERE

clause of a GET call was incorrectly negated.

2845172 (1102400)

Interface Mapping Toolkit

Back to the list

• Ebiz execution no longer fails when tracing is enabled and several programs contain a mismatched
linkage offset.

• JSON request messages containing multi-byte UTF8 characters caused errors for REST web services.

JCL Support

Back to the list

• MFDB2UNL did not process the SELECT statement correctly if it started in a column other than 1.

2845002 (1102407)
• An issue that caused SSTM and JCL-enabled regions to hang when starting has been resolved.

2849994 (1103031)
• IDCAMS ALTER now supports renaming of physical files if they have an environment variable specified

in their paths. To enable this behavior, you must set the environment variable MF_PCRENAME_LAX to
'Y'.

2848692 (1102898)
• When assigning a new job number, records from past jobs with the same job number were erroneously

included in the job listing.

2847426 (1102709)
• The spool housekeeping utility, mvssplhk, now does not delete active CICS SSTM jobs. It is possible to

remove expired SYSOUT datasets from the jobs.

2847421 (1102708)
• It is now possible to include key offset and length information when replacing cataloged VSAM index

and data elements using MVSCATPB.

2846554 (1102608)
• MVSSPLHK has been updated so you no longer receive a duplicate error when the CATALOG is

archived.

2846100 (1102623)
• Using the MFCATXML or the MVSCATPB REPL function to replace a catalog no longer causes the

enterprise server to hang.

2846018 (1102524)
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• When loading catalog records from an XML file using MFCATXML, the pds extensions from earlier
records are no longer carried forward.

2845761 (1102519)
• Quoted values are now supported for the PRTQUEUE OUTPUT statement.

2844696 (1102356)
• Job outputs are now correctly being sent to the printer exit when there is a heavy JES workload.

2844053 (1102254)
• The following DATACLAS parameters are now supported: AVREC/AVGREC, DSORG and RECORG.

2842497 (1102064)
• A DD referback was incorrectly using the catalog properties of the file referred to and not just those

DCB parameters defined on the referred to DD card.

2842304 (1102044)
• The MVSSPLHK housekeeping process now correctly removes JOB99999.

2842083 (1102018)
• The Micro Focus emulation of ICETOOLS no longer incorrectly processes the RDW directive twice.

Previously, this would lead to lost data.

2841136 (1101894)
• A JESYSMSG for a reprinted job now correctly displays in the JES Spool>Printed queue.

2840462 (1101867)
• The change date in the catalog was not being updated for concatenated datasets. The catalog now

shows the time/date for the end of step processing for all concatenated datasets.

2840128 (1101779)
• When the first job run uses 2 programs that both open the same file, the Shareoption Manager no

longer incorrectly returns an access denied message.

2839737 (1101834)
• Where appropriate, LEX files are now correctly removed during the MVSSPLHK spool housekeeping

process. Previously, if the ES_ALLOC_OVERRIDE variable specified a different location to the
MFALLOC_LOC variable these files could be missed. Also, the message for casspool record type 16
records in SYSPRINT now displays correctly.

2839699 (1101778)
• A SORT operation on a Variable Block file where INREC processes are specified no longer incorrectly

changes all records to Fixed Block.

2839561 (1101737)
• The correct next bias number for GDGs will be used when existing biases are removed.

2837967 (1102225)
• The casout /g<jobnum> command now works correctly when ES_JESYSMSG_OUTPUT=Y is set.

2837860 (1101512)
• The IDCAMS REPRO command generates a file status 35 if the physical file of a cataloged input file

does not exist.

2837596 (1101509)
• A problem where incorrect HSF stats were being reported for the SSTM job has been corrected.

2837158 (1101448)
• If a printer exit requests removal of the JESYSMSG (JCL Job log), any OUTPUT statement and

SUBSYS information is retained. If restart is enabled, the job log and other job files required for
restarting are not removed.

2836023 (1101573)
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• When copying SYSUT1 to SYSUT2 (using IEBGENER), where SYSUT2 is a spool file with no RECFM
supplied in the JCL, the SYSUT1 RECFM is now used if it is valid. Previously, it was only being used
when set to "F".

2834419 (1101200)
• It is now possible to scroll backwards from the first spool display page to the last one. If the spool file is

rather big, however, scrolling could be slow as all the spool records need to be processed before the
last page is displayed. This is the expected behavior.

2833812 (1101030)
• You no longer receive a file locked error when JCL accesses CICS shared files.

2833284 (1101010)
• JCL validation no longer fails an OUTPUT statement that has no parameters.

2833175 (1100991)
• An error in the JCL scanner that reported a JCL error when scanning a job that contained a NULL IF

statement has been corrected.

2832582 (1101015)
• The JCL COND CODE for PRINTED queue records was displayed with invalid characters.

2831180 (1100784)
• A problem that resulted in receiving an RTS 114 error when clicking on the REPLY button has been

fixed. This would happen if you were using dynamic debugging to debug a JCL job and clicked "Stop
Debugging" while the job was still waiting for an input from the user.

2828547 (1100819)
• MVSSPLHK now scans the LEX file directory for orphan LEX files, and deletes them if they are older

than the max retain period.

2826722 (1100693)
• Using DSNRLI with multiple XA switch modules and performing a 'SWITCH-TO' action to a XA resource

with a name shorter than the previous resource, caused an error with a return code of 4 and a reason
code X'00C12205'. The DSNRLI module now correctly performs 'SWITCH-TO' actions.

• Enterprise Developer now provides a new utility, MFJPTPCH, that emulates the IEBPTPCH (Print-
Punch) utility.

• This release provides a new environment variable, MVSSPOOLDIR, which can be used to direct spool
control files to a location which is different to the location of the main catalog file.

2839703 (1101713)
• It is now possible to configure multiple user catalogs for Enterprise Server.

2514366 (1101309)

• The SETPARM statement can now be used with the IF statement. For example: SETPARM pppp=xxxx
IF pppp=xxxx

2820858 (1099472)

Mainframe Access

Back to the list

• In the shipped MFAAS JCL proc required for the Changeman dependent server, a DD CEEOPTS points
at a member in the Mainframe Access parameter library. Because the CHM support changes the ACEE
task to that of the user, the user must have read access Mainframe Access MFA parameter library. If
this is not acceptable, to work around this issue, you need to:

1. Remove the CEEOPTS statement. The EXEC PARM field can be changed to
PARM='TRAP(OFF,NOSPIE)/', if required.
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2. Move the CEEOPTS member to a world-readable library.

MFIO

Back to the list

• Enterprise Developer now includes the SourceConnect functionality.

2807623 (1098289)

Micro Focus Common Client

Back to the list

• COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server

Back to the list

• Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

2846804 (1102971)
• Enterprise Server instance startup performance has been improved, particularly when the Enterprise

Server Administration GUI has been configured to use SSL.

2837359 (1101501)
• Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if

configured to use an SSL browser connection.

2834446 (1101342)
• The Enterprise Server user id no longer needs to have security administration access permissions to

start an Enterprise Server instance if external security is specified.

Monitoring and Management

Back to the list

• The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .

2830110 (1100895)

Run-Time System

Back to the list

• If a file is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.

2837230 (1101419)
• 64-bit Windows only, and native generated code only. Programs containing code of the form 01 f

comp-2. compute f = f ** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".

2836893 (1101465)
• Under Enterprise Server, a stateful web service containing CICS code no longer hangs if a runtime

error occurs in a nested link level.

2836252 (1101438)
• When using "mfauditadm -r" on an audit file containing processes that have very long command lines,

the process could terminate early with a memory fault. This has now been resolved.
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2832770 (1101000)
• Repeatedly calling and cancelling different programs in different threads could cause the application to

hang. This has now been resolved.

• In the .NET runtime, a managed executable can now be successfully executed using
CBL_EXEC_RUN_UNIT when an explicit .exe extension is specified in the program name.

2845604 (1102669)
• A new library routine, PC_PRINTER_INFO_DOTNET, is now available for .NET COBOL applications. It

enables the access to the .NET Graphics/PageSettings objects.

2845991 (1102545)
• .NET COBOL applications can now use PC_PRINTER_LOAD_BMP more than once without this

causing unexpected exceptions.

2845991 (1102546)
• Applications that use run units created with the MicroFocus.COBOL.RuntimeServices class could leak

memory.

2838583 (1101639)
• The XML I-O preprocessor no longer incorrectly represents some fixed point values in floating point

format.

2837561 (1101473)

SQL: COBSQL

Back to the list

• The COBSQL preprocessor has been updated to correctly handle P(CP) with the NOSQL directive.

2850394 (1103086)
• Background parse should now create temporary files with names that differ from the actual build

process.

2843719 (1102613)

HCO for DB2 LUW

Back to the list

• A compiler error that resulted from the DB2 ECM preprocessor incorrectly handling embedded
comments within an SQL statement has been fixed.

2846756 (1102646)
• An HCO pre-compiler routine incorrectly replaced an underscore in host variable name which resulted

in invalid host variable. This has now been fixed.

2837674 (1101487)

SQL: OpenESQL

Back to the list

• An overflow problem with host variables of type System.Decimal has been fixed.

2849939 (1103195)
• OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC

in a managed application.

2847268 (1102968)
• A problem with EXEC ADO REBIND CONNECTION has been fixed.

2846426 (1102645)
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• In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables
defined with zero (0) length.

2845409 (1102510)
• HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for

SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

2844292 (1102483)
• HCOSS did not fully support DB2 ROW_NUMBER().

2843937 (1102362)
• Using SQL(CHECK) with .NET applications caused an error on Oracle.

2842102 (1102037)
• The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column

where the field is zero length.

2841149 (1102637)
• The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on

the COBSQLTYPE options list.

2840953 (1101877)
• An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL

errors.

2837717 (1101484)
• HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)

columns.

2832384 (1101169)
• The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when

SQL(ISOLATION) was set.

2797208 (1096456)

• To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.

2850022 (1103058)
• To correct a problem with closing CURSORs, SQL(SPCALLLOCAL) can now be used to instruct

OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.

2848402 (1102838)
• When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement

prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).

2847791 (1102782)
• OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL

Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.

2846825 (1102701)
• When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that

included literals containing angle bracket characters has been corrected.

2846226 (1102582)
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• A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not
parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

2844399 (1102329)
• The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously

omitted from the drop-down list in the user interface.

2842879 (1102128)
• When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error

occurred when the same cursor was opened and closed multiple times.

2841857 (1102003)
• The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length

input host variables that used an explicit-length field.

2841721 (1102106)
• A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has

been fixed.

2841508 (616495)
• When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with

embedded spaces.

2839826 (1101752)
• In European locales, Oracle queries failed to return the decimal symbol for floating point results

returned to decimal numeric host variables.

2839066 (1102162)
• OpenESQL SAVEPOINT handling was not working as expected with Static SQL.

2838227 (1101571)
• An HCOSS stored procedure called from multiple locations in either the calling application or in a

nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.

2834386 (1101104)
• HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a

stored procedure name in a host variable.

2833755 (1101022)
• OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned

values now correctly represent a 24-hour clock.

2833683 (1101017)
• The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.

2829499 (1102075)
• When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect

TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.

2823577 (1099922)
• The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X

host variables with CHAR and VARCHAR columns.

2806980 (1097582)
• An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now

returns errors rather than warnings. HCOSS is not supported in Visual COBOL.
• OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition

to the original partially managed provider. Note: The two providers are not 100% compatible. The
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partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

SQL Option for DB2

Back to the list

• The XDB pre-processor incorrectly processed SQL statement that had embedded singles within a
literal. This resulted in receiving an incorrect message "cobsql0111e - no from clause specified error".

2850293 (1103073)

• When using an open cursor with constants comparison in an IN () clause, an Sqlcode -1352 error
occurred.

2844111 (1102266)
• An SQL statement with SELECT caused an XDB with Server Violation error when converting from the

CHARACTER to INTEGER type in the INSERT SQL statement.

2839382 (1101677)
• Incorrect results sometimes occurred when using a host variable for the second parameter of the SQL

scalar function ROUND() function.

2831359 (1101083)

• Exiting SQLWizard processing no longer causes an exception.

2849696 (1103097)
• A problem with the display of code page conversions in the SQLWizard Import/Export dialog boxes has

been resolved.

2846196 (1102659)
• An issue that resulted in a syntax error when editing tables with decimal data has been resolved.

2840937 (1101960)
• Exporting a table with a reserved word as a column name no longer produces an error X020 if the

quoting types are Apost or Quote.

2806803 (1097559)

• An RTS 114 error would sometimes occur on an UPDATE WHERE CURRENT OF CURSOR.

2840936 (1101868)
• When executing a batch job containing XDB Null loads, an error occurred during DSNUTILB processing

when loading the XICU40N DLL.

2840147 (1101785)
• An execution error resulted when using dynamic SQL with an SQLDA SQLN integer much larger than

required for input parameter markers.

2818992 (1099256)

XML Support

Back to the list

• PREXML now terminates and returns an error message if there is a problem expanding a copybook.

2472213 (1076394)
• XMLPARSE did not honor the encoding in the XML declaration for output text.

2851343 (1103239)
• XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document

contains an XML declaration.

2837110 (1101424)
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• XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.

2822339 (1099692)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2266906 (1066314)
• 2541594 (1081441)
• 2610077 (1087571)
• 2613606 (1088533)
• 2691674 (1093498)
• 2784725 (1095083)
• 2792882 (1102055)
• 2801626 (1097006)
• 2801847 (1097374)
• 2805056 (1097357)
• 2806566 (1097816)
• 2807649 (1097763)
• 2809132 (1097892)
• 2812331 (1098359)
• 2815582 (1099634)
• 2817630 (1101066)
• 2824712 (1100086)
• 2824925 (1099961)
• 2825098 (1100032)
• 2825249 (1101374)
• 2827707 (1100302)
• 2828305 (1100419)
• 2828897 (1100491)
• 2829677 (1100588)
• 2830741 (1100655)
• 2830871 (1100785)
• 2831477 (1100831)
• 2831788 (1100810)
• 2831959 (1100864)
• 2832490 (1100907)
• 2832904 (1100916)
• 2833083 (1101060)
• 2833100 (1101123)

• 2833473 (1101007)
• 2833925 (1101045)
• 2834217 (1101124)
• 2834245 (1101085)
• 2834253 (1101099)
• 2834843 (1101156)
• 2834959 (1101167)
• 2835289 (1101498)
• 2835416 (1101496)
• 2835506 (1101288)
• 2835508 (1101292)
• 2835599 (1101293)
• 2835608 (1101494)
• 2835687 (1101497)
• 2835835 (1101262)
• 2836694 (1101356)
• 2837531 (1101490)
• 2837784 (1101511)
• 2838086 (1101525)
• 2838343 (1101586)
• 2838426 (1101552)
• 2838593 (1101986)
• 2838671 (1101587)
• 2838689 (1102052)
• 2839730 (1101776)
• 2840155 (1101821)
• 2840349 (1101906)
• 2840530 (1101860)
• 2840658 (1101893)
• 2840766 (1101857)
• 2840977 (1102019)
• 2841607 (1101961)
• 2841785 (1101988)

• 2841933 (1102021)
• 2842318 (1102129)
• 2842702 (1102121)
• 2842940 (1102122)
• 2843048 (1102186)
• 2843076 (1102135)
• 2843140 (1102509)
• 2843301 (1102185)
• 2843324 (1102296)
• 2843438 (1102240)
• 2843446 (1102173)
• 2843446 (1102174)
• 2843884 (1102492)
• 2845184 (1102627)
• 2845218 (1102490)
• 2845635 (1102601)
• 2845781 (1102730)
• 2846150 (1102557)
• 2846669 (1102644)
• 2846797 (1102780)
• 2846971 (1103070)
• 2847253 (1102806)
• 2847876 (1102765)
• 2848324 (1103143)
• 2849271 (1103044)
• 2849307 (1102974)
• 2849430 (1103011)
• 2849508 (1102970)
• 2849972 (1103094)
• 2851114 (1103175)
• 2851169 (1103174)
• 2852143 (1103362)

Other Issues Resolved in This Release  | 27



Installation

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

System Requirements

Hardware Requirements
The disk space requirements are approximately:

Enterprise Test Server Sentinel RMS License Manager

1.2Gb 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

Software Requirements
Note:

• The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components. It will also install the Micro Focus
Database Engine.

• This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.
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Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in Enterprise Test Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active
content must be allowed and not blocked. To enable both these in Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some Enterprise Test Server features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Test Server setup file.

Click here to see this information on the Micro Focus Infocenter.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:
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1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Test Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

• To use Data Manager, you must obtain an Enterprise Test Server Premium license. Once you have
procured a Premium license, Micro Focus provides an electronic product download (EPD) that enables
you to install the Data Manager for z/OS component, which is a separate installation from Enterprise
Test Server. See Installing Data Manager in your product help for details.

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Enterprise Server and Enterprise Test Server cannot coexist on the same machine.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks.

Installing
Note: If there is an earlier version of Enterprise Test Server installed on your machine, check
Installing as an Upgrade first.

These are the steps to install this product:
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1. Run the ets_231.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in Software Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Test Server but you can install it if you wish.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade
• Command line installation options

To see this information on the Micro Focus Infocenter, click here.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Test Server Installation Options
To install Enterprise Test Server you run ets_231.exe which contains a number of product .msi files
(Windows Installer packages). When run, ets_231.exe performs some initial system checks then
sequentially installs the .msi files.

ets_231.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
ets_231.exe
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Summary:
Full installation including License Manager and Enterprise Test Server. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
ets_231.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
ets_231.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
ets_231.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Test Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: ets_231.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
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1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Enterprise Test Server and
Micro Focus License Administration. Uninstalling only Enterprise Test Server does not automatically
uninstall the Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall
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Licensing Information
Note:

•
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• Be aware that the person who purchased this product has had to sign a license which states that

you may use this product for testing only, and not for development work. If you are uncertain as to
whether you will need to do development work, we recommend you speak to the person who
purchased the product to see if you need a different license.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

If you have an authorization code

Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
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1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Data Manager

When using Data Manager, please be ready to provide the following in addition:

• The version number for the z/OS component, found on the Main Menu panel.
• Whether you are using the Standard or Client/Server configuration.
• The data stores you are working with, including client-side and server-side versions where appropriate.
• Details of the data store contents, for example:

DDL, DCLGEN, or SYSPUNCH  (for SQL data stores)
Copybooks (SEQ, VSAM, GDG, DL/I)
FDT (ADABAS)
DBD (DL/I)

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2016. All rights reserved.
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